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1. Introduction 
 

1.1 Additional Module STEEL 

STEEL is not an independently running program. It is closely integrated in the user interface 
of the main program RSTAB. The structure specific input data as well as the internal forces 
are thus available for the module. On the other hand, the STEEL results can also be eva-
luated in the RSTAB work window and you can include them in the global printout report. 

STEEL delivers general stress analyses by calculating the existing stresses and then by com-
paring these with the limit stresses. For this, an extensive cross-section library and an ex-
tendable material library with the standard specific limit stresses are available. Every cross-
section has design-related stress points. These are also available for the graphical evalua-
tion. 

During the stress analysis, also the maximum stresses for sets of members are determined 
and the governing internal forces will be documented. In addition, STEEL also offers an au-
tomatic cross-section optimization including an option to export the optimized cross-
sections to RSTAB. 

Separate STEEL design cases allow for flexible examination of stresses. The design is com-
pleted by a parts list with quantity survey. 

Essential innovations in STEEL are: 

• Display of the maximum stress ratios in the cross-section mask to facilitate the cross-
section optimization 

• STEEL masks linked to the RSTAB work window so that the current objects are hig-
hlighted in the background graphics 

• View mode to change the graphical display in the RSTAB work window 

• Colored relation bars in the results masks 

• Quick info of fulfilled or failed stress design 

• Display of the STEEL stresses and stress ratios as result diagrams 

• Filter option for the stress display in the RSTAB graphics 

• Display of the STEEL stresses and stress ratios on the rendered model 

• Direct data export to MS Excel 

We wish you much success using STEEL. 

 

DLUBAL ENGINEERING SOFTWARE 
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1.3 Using the Manual 
Details to installation, user interface, results evaluation and printout can be found in the 
RSTAB manual. This manual focuses on the particularities that occur when working with the 
additional module STEEL. 

The STEEL manual follows the sequence and the structure of the input and results masks. 
The text presents the described buttons in square brackets, e.g. [OK]. They are also shown 
on the left. The used expressions for dialogs, tables and menus are set in italics to clarify 
the explanation. 

This manual features also an index to find certain expressions quickly. If you should not find 
what you are looking for, please check our website at www.dlubal.com where you can go 
through our well-organized FAQ pages. 

 

1.4 Starting STEEL 
You have the following options to start the add-on module STEEL.  

Menu 
STEEL can be called via menu 

Additional Modules → Design - Steel → STEEL. 

 
Figure 1.1: Menu: Additional Modules → Design – Steel → STEEL 
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Navigator 
In the Data navigator, you can open STEEL via the item 

Additional Modules → STEEL. 

 
Figure 1.2: Data-Navigator: Additional Modules → STEEL 

Panel 
If the RSTAB structure already contains STEEL results, you can select the STEEL case in the 
load case list. The stresses and stress ratios can be displayed in the graphics via the button 
[Results on/off]. 

 

     

Now, the button [STEEL] becomes available in the panel to call up the module STEEL. 

 
Figure 1.3: Panel: Button [STEEL] 
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2. Input Data 
The input for the definition of the design cases is carried out in masks. The module offers 
also the [Pick] function to select members and sets of members in the graphics. 

After starting STEEL, a navigator appears in a new window that lists all available masks. A 
pull-down list at the top offers all available STEEL Cases (see chapter 7.1, page 47). 

When STEEL is opened for the first time in a RSTAB structure, then the module imports the 
following design-related data automatically: 

• members and sets of members 
• load cases, load groups and load combinations as well as super combinations 
• materials 
• cross-sections 
• internal forces (in the background - if calculated) 

The masks  can be scrolled through either by clicking on a selected item in the STEEL navi-
gator or by clicking on the buttons shown on the left. The buttons [F2] and [F3] can also be 
used to scroll one mask forward or backward. 

     

[OK] stores the input and closes the STEEL module. [Cancel] closes the module without stor-
ing any data. 

2.1 General Data 
In mask 1.1 General Data, you have to select the members and actions for the design. The 
design standard will be defined in mask 1.2 because it is linked to the material properties. 

 
Figure 2.1: Mask 1.1 General Data 
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Design 
The design can be carried out for Members as well as for Sets of Members. If only selected 
objects are to be designed, the checkbox All must have been deactivated. This makes the 
input boxes accessible and the numbers of the selected members resp. sets of members can 
be entered. With [Pick], you can also select the relevant objects graphically in the RSRTAB 
work window. The list of the preset member numbers can be selected quickly by double 
clicking it. Then, it is possible to overwrite the list. 

 

If no sets of members have been defined in RSTAB, you can create them also in the STEEL 
module via the button [New]. The dialog for creating a new set of members appears which 
is already familiar from RSTAB. There, the specifications can be made. 

 

The advantage of the sets of members design is that selected members can be designed to 
determine the total maxima of their stresses and stress ratios. In this case, the results masks 
2.2 Stresses by Set of Members and 3.3 Parts List by Set of Members will be displayed. 

Existing Load Cases / Load Groups and Combinations 
These two sections contain all design-relevant load cases, load groups, load combinations 
and super combinations that have been defined in RSTAB. Button [ ] moves the selected 
load cases resp. combinations to the list Selected for Design. This action can also be carried 
out by double clicking the relevant items. Button [ ] transfers the entire list to the right. 

 
 

 

Load cases that are marked with an asterisk (*), e.g. load cases 8 to 10 in Figure 2.1, are ex-
cluded from the design. This is the case when no load has been defined or when those are 
imperfection-type load cases as in the example above. 

Selected for Design 
The selected actions for the design are listed in the right column. Button [ ] removes only 
the selected item from the list. As before, you can also select by double clicking on the item. 
Button [ ] removes all items from the list. 

 
 

 The design of an enveloping Or load combination is faster than analyzing all contained load 
cases or load groups. On the other hand, the governing actions for the design of a com-
plete combination will not be too transparent. The max/min stresses of each load case or 
load group are used for the design that are then superimposed according to the relevant 
code. For load combinations, it is recommended to check the Method of Stress Calculation 
in dialog Details (cf. chapter 3.2, page 20). 

 

 

Comment 
This input box can be used for user defined comments, e.g. to describe the design case. 
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2.2 Materials 
This mask has two parts. The upper section lists materials including the limit stresses that 
have been selected for the design. The section Material Properties lists the constants of the 
current material, i.e. the material that has been selected in the upper section. 

Details to the material properties for the determination of the internal forces can be found 
in chapter 5.2 of the RSTAB manual. The design-relevant material properties are stored in 
the global material library and are set automatically. These can be adjusted in this mask. 

The units and decimal places of the material constants and stresses can be edited via menu 
Settings → Units and Decimal Places. 

 
Figure 2.2: Mask 1.2 Materials 

Material Description 
The materials that have been defined in RSTAB are set by default. If the Material Description 
corresponds to an item of the material library, STEEL automatically imports the design-
relevant material constants. 

The material selection can be carried out via the list: Place the cursor in column A and then 
click the button [ ] or press the function key [F7]. The list shown on the left appears. After 
the import, the design relevant parameters are entered in the remaining fields of the row. 

 

The list contains only STEEL materials. In general, any material can be designed with a stress 
concept based on the comparison of the existing axial, shear and equivalente stresses with 
the limit stresses. In this way, also the design of aluminum or high grade steel cross-
sections can be carried out. Of course, the appropriate standards have to be considered as 
well. 

If there is a material name with non-defined limit stresses (e. g. timber), then the entries of 
this row are displayed in red. User-defined limit stresses can also be entered by activating 
the function Manually in column D. The red entries disappears as soon as the permitted 
stresses have been defined in columns E to G. 

The import of materials from the library is described further below. 

 



2  Input Data 

Safety Factor γM 

This factor describes the safety factor for calculating the design values of the material stiff-
ness. Therefore, the index M is used. The characteristic value of the yield strength fyk for the 
determination of the limit axial and bending stress σR,d (see Equation 2.1) and the limit 
shear stress τR,d (Equation 2.1) is reduced by this factor γM. 

When therefore calculating according to 2nd or 3rd order analysis, the factor γM enters the 
design twice: First, a stiffness reduced by 10 % has to be considered for the influence of the 
deformations when determining the internal forces according to DIN 18800 T2, El. (116), 
and then the design values of the stiffnesses for the limit state are to be reduced by the 
partial safety factor γM. 

Yield Strength fyk 

The yield strength describes the limit to which the material can be strained without perma-
nent deformation. The characteristic values of different steel grades can be taken from e.g. 
DIN 18800 T1, section 4 und EC 3, section 3. 

Limit Stresses 
For materials that are contained in the general material library, the limit stresses are set au-
tomatically and can not be modified here. 

If you want to modify the limit stresses, then you have to change the material properties via 
the button [Edit Material] (see page 13) or the checkbox Manual. 

Manually 
If this checkbox has been activated then you can define the following columns manually. 

Modified materials are marked in the column Material Description by an asteriskr. 

Limit σx 
The limit normal stress represents the allowable stress for the loading due to bending and 
axial force. It is defined according to DIN 18800 T1, El. (746) by the characteristic value of 
the yield strength that is reduced by the partial safety factor γM. 

11Program STEEL © by Dlubal Engineering Software 

M

yk
d,R,x

f

γ
=σ  

Equation 2.1 

Limit τ 
The limit shear stress specifies the allowable shear stress due to shear force and torsion. 
According to DIN 18800 T1, El. (746), the partial safety factor γM enters the equation for the 
determination of the limit shear stress, too. 

3

f

M

yk
d,R

⋅γ
=τ  

Equation 2.2 

Limit σv 
The limit equivalent stress represents the allowable comparative stress for the simultaneous 
action of several stresses. It is also defined e.g. by Equation 2.1 according to DIN 18800 T1, 
El. (746). 

Yield Strengths Subject to Component Thickness 
For some materials, the characteristic yield strength fy,k is related to the thickness of the 
member components t. The Maximum Structural Thickness of the selected ranges including 
the corresponding yield strength is displayed in the lower section Material Properties. 
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The assignment of the yield strengths is managed in the codes, e. g. table 1 of DIN 18800 
T1. Via the button [Edit Material], you can control and, if needed, edit the component 
thicknesses and the assigned stresses (cf. page 13). 

Material Library 
Many materials are already stored in a library. It can be called up via menu 

 
Edit → Material Library 

or the button shown on the left. 

 
Figure 2.3: Dialog Material Library 

In section Filter Choice, the material category Steel is preset. From the list Material to Select, 
you can select a material and in the lower part of the dialog you can check its parameters. 
With [OK] or [↵] you can set it in the STEEL mask 1.2. 

Details on how to filter, add or reorganize materials can be found in chapter 5.2 of the 
RSTAB manual. 

When selecting another material category than Steel, you have to consider that only mate-
rials can be designed with a stress concept that is based on the comparison of the existing 
axial, shear and comparative stresses with the allowable stresses. In this way, also the de-
sign of aluminum or high-rade steel cross-sections can be carried out in principle. 

If a material with non-defined limit stresses (e.g. timber) is imported, then the entries of 
this row in mask 1.2 is displayed in red. User-defined limit stresses can also be defined by 
activating the function Manually in column D. The red entries disappear as soon as the limit 
stresses have been entered in columns E to G . The stress design for e.g. timber cross-
sections can only be carried out incompletely because the relevant codes require differen-
tiated criteria. For this, the add-on module TIMBER is recommended. 
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Edit Material 
The yield strengths and limit stresses of the current material can be adjusted via the button 
shown on the left. The following dialog appears.  

 
Figure 2.4: Dialog Edit Material 

The defined characteristic values of the yield strength fyk are reduced by the factor γM in sec-
tion Partial Safety Factor. The resulting limit stresses according to Equation 2.1 and 
Equation 2.2 (page 11) are listed in columns D to E. 

In section Yield Strengths and Limit Stresses Subject to Component Thicknesses, the ranges 
of the Member Thickness t can be modified. The number of the ranges is set by the codes. 
The range limits can be modified by defining different values in column B manually. Column 
A will be automatically adjusted. A specific Yield strength fyk can assigned to every range. 

If the limit stresses are to be defined freely, then the checkbox User-defined, Independent 
Definition of the Limit Stresses is to be activated. Columns D to E then become accessible 
for user-defined entries. 

Modified materials are marked by an asterisk in mask 1.2. 
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2.3 Cross-Sections 
This mask controls the cross-sections for the design and the optimization parameters. 

 
Figure 2.5: Mask 1.3 Cross-Sections 

Cross-Section Description 
When calling up this mask, the cross-sections used in RSTAB are preset including the corres-
ponding material numbers. 

These cross-sections can be edited for the design. The description of a modified cross-
section will be marked in blue in column B. 

In order to edit a cross-section, the new description can be entered in the corresponding 
row, or the new cross-section is selected from the library. It can be called up as usual via the 
[Cross-Section Library] button. Alternatively, place the cursor in the selected row and then 
press [...] or the function key [F7]. The library which is already familiar from RSTAB appears. 
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Figure 2.6: Cross-Section Library 

Details to the selection of cross-sections from the library can be found in chapter 5.3 of the 
RSTAB manual. 

 

If there are different cross-sections in STEEL and RSTAB, then the figure on the right of the 
mask shows both cross-sections. The stress design is then carried out with the internal 
forces from RSTAB for the cross-section that was defined in STEEL. 

Member with Tapered Cross-Section 
For tapered members with different cross-sections at member start and member end, the 
two cross-section numbers are displayed in two lines following the definition in RSTAB. 
STEEL carries out the design of tapered members as long as the following condition is ful-
filled: An equal number of stress points is required. 

The axial stresses are for example determined from the moments of inertia as well as from 
the centroid distances of the stress points. STEEL can not interpolate the intermediate val-
ues if the number of stress points for the start and end cross-section of a tapered member 
is different. In that case, RSTAB assumes for the calculation and for the 3D rendering the 
two cross-section properties for each member half. In STEEL, however, no design is possible. 
A warning will appear before the calculation. 

 
Figure 2.7: Figure 2.8: Warning for incompatible cross-sections 

You can check the stress points of a cross-section and their numbering in the cross-section 
graphics on the right. Details to the stress points can be found in chapter 4.1, page 24.      

Thus, for a successful design an equal number of stress points has to be generated. This can 
be achieved, for example, by modeling the taper as a copy of the start cross-section and 
then modifying the geometrical parameters. If required, the two cross-sections should be 
defined as parametrized, i.e. welded, cross-sections. Especially for tapers, the ICU tpye 
Combined Sections I-Section Plus Cut Section Below is recommended. 
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Maximum Design Ratios 
This column assists with the optimization process. It is displayed when a design was already 
carried out. The ratio of design and the color relation scales show which cross-sections have 
a low design ratio and therefore will be oversized resp. are overstrained and therefore will 
be too weak. 

Optimizing 
Every cross-section can be subjected to an optimization process. Here, the internal forces of 
RSTAB are used to determine the cross-section in the same cross-section group that is clos-
est to the maximum stress ratio of 1.0. 

If a selected cross-section is to be optimized, the checkbox in column D has to be activated. 
Recommendations for the cross-section optimizations can be found in chapter 7.2, page 49. 

Comment 
In this column, comments are shown as footnotes and are explained in the lower part of 
the cross-section list. 

If comment 1) The cross-section will not be designed because the cross-section data are not 
defined! appears, then you deal with an unknown cross-section that is not registered in the 
cross-section library. This might for example be a user-defined cross-section or a section 
that was not calculated in SHAPE-THIN. In this case, you should return to RSTAB and com-
plete the required entries for e.g. the stress points (see chapter 5.3 of the RSTAB manual, 
section Create User-Defined Cross-Section). 

Cross-Section Graphics 
The current cross-section is displayed in the right part of mask 1.3. The buttons shown be-
low have the following functions: 

 

 

 

Button Function 

 
The dimensioning of the cross-section is switched on and off. 

 
The principal axes of the cross-section are switched on and off. 

 
The stress points are displayed or switched off. 

 
The numbering of the stress points is switched on and off. 

Table 2.1: Buttons in the graphics 
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3. Calculation 
The stress analysis is carried out with the internal forces that have been determined in 
RSTAB. Before starting the [Calculation], the design details should be checked. This dialog is 
called up via [Details]. Details can be found in chapter 3.2, page 20. 

 
 

 

3.1 Stresses and Stress Ratio 
The axial stresses σtotal, τtotal and σeqv are shown in masks 2.1 to 2.5. The individual stress 
components can be switched on via the buttons [Select Stresses to Show] and [Show or 
Print Cross-section Values and Extended Stress Diagram]. 

    

Axial Stresses 
According to the typical conventions, tensile stresses are issued with positive signs and 
compressive stresses with negative signs. 

The analysis is carried out for every individual stress point so that usually not all compo-
nents of the maximum stresses must be added for the combined evaluation (z. B. σtotal): In 
most cases, these are available at different stress points. The relevant stress components of 
the selected stress point have to be superimposed. 

 

Their meaning of the axial stresses σ is as follows: 

σN 

Stress due to axial force N 

A
=σ
N

 

with A: Cross-section surface of the cross-section 

σM-y 

Stress due to bending moment My 

z
y e

M
⋅=σ

yy,pl I⋅α
 

with αpl,y: plastic form coefficient acc. to  DIN 18800 T1, El. (750) 
 Iy: moment of inertia with reference to principal axis y 
 ez: Centroid distance of the stress point in direction z 

σM-z 

Stress due to bending moment Mz 

y
z e

M
⋅−=σ

zz,pl I⋅α
 

with αpl,z: plastic form coefficient acc. to DIN 18800 T1, El. (750) 
 Iz: moment of inertia with reference to principal axis z 
 ey: Centroid distance of the stress point in direction y 

σM 
Stress due to bending moments My and Mz 

y
z

z
y e

M
e

M
⋅−⋅=σ

zz,plyy,pl II ⋅α⋅α
 

σTension 
Tensile stress due to axial force N and bending moments My and Mz 

y
z

z
y e

M
e

MN
⋅−⋅+=σ

zz,plyy,pl IIA ⋅α⋅α
 

σCompression 
Compressive stress due to axial force N and bending moments My and Mz 

y
z

z
y e

M
e

MN
⋅−⋅+=σ

zz,plyy,pl IIA ⋅α⋅α
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σDelta 
Maximum difference between the axial forces of the individual load cases, 
e.g. for the fatigue design 

σtotal 
Total axial stress due to axial force N and bending moments My and Mz 

y
zz,pl

z
z

yy,pl

y e
I

M
e

I

M

A
N

⋅
⋅α

−⋅
⋅α

+=σ  

Table 3.1: Axial stresses σ 

The local member axis system influences also the signs of the internal forces. 
 

 
Figure 3.1: Positive definition of the internal forces 

The bending moment My is positive when tensile stresses occur on the positive member 
side (in direction of axis z). Mz is positive when compressive stresses occur on the positive 
member side (in direction of axis y). The sign definition for torsional moments, normal 
forces and shear forces conforms to the usual conventions: The internal forces are positive if 
they act in a positive direction. 

Shear Stresses 
Their meaning of the shear stresses τ is as follows: 

τV-y 

Stress due to axial force Vy 

tI

QV

z

zy

⋅

⋅
−=τ  

with Qz: statical moment of area with reference to principal axis z 
 Iz: moment of inertia with reference to principal axis z 
 t: Governing thickness of the cross-section 

τV-z 

Stress due to shear force Vz 

tI

QV

y

yz

⋅

⋅
−=τ  

with Qy: statical moment of area with reference to principal axis y 
 Iy: moment of inertia with reference to principal axis y 
 t: Governing thickness of the cross-section 

τV 

Stress due to shear forces Vy and Vz 

tI

QV

tI

QV

y

yz

z

zy

⋅

⋅ ⋅
−=τ −

⋅
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τM-T, St.Venant 

Stress due to torsional moment MT for open cross-section 

t
I
M

.V.St,T

T ⋅=τ  

with IT,St.V.: Torsional moment according to Saint Venant 

 t: Governing thickness of the cross-section 

τM-T, Bredt 

Stress due to torsional moment MT for hollow cross-section 

tA2
M

m

T

⋅⋅
=τ  

with Am: surface that is enclosed by the cross-section center lines 

 t: Governing thickness of the cross-section 

τM-T 

Stress due to torsional moment MT 

t
I
M

.V.St,T

T ⋅=τ   or  
tA2

M

m

T

⋅⋅
=τ  

τtotal 
Total shear stress due to shear forces Vy and Vz and torsional moment MT 

TMV= τ + ττ  

Table 3.2: Shear Stresses τ 

For the determination of the shear stresses due to shear forces, the statical moments are 
used, not the shear surfaces of the cross-section. 

For the shear stresses due to torsion, the following must be observed: 
 

• If the current cross-section is only partially open and contains a hollow cell, then the 
complete cross-section will be classified as hollow. In this case, the shear stress is de-
termined exclusively according to Bredt's formula. Unlike the cross-section program 
SHAPE, no analysis will be carried out by its components of MT,St.Venant and MT,Bredt. 

• The influence of the torsional buckling can not be determined in STEEL. The design is – 
like the internal force determination in RSTAB – limited only to the primary torsional 
moments. If the warping stresses due to secondary torsional moments or bimoments 
can not be neglected, then the additional module FE-LTB is recommended. 

Equivalent Stress 
The equivalent stress σeqv is determined e.g. according to DIN 18800 T1, El. (748) as fol-
lows: 

σeqv 

Equivalent stress resulting from the axial stresses σ and shear stresses τ 
22

total ff τ⋅+σ⋅=σ  

 f2: Factor for shear stresses 

total21eqv

with f1: Factor for axial stresses 

Table 3.3: Equivale

e factors f1 = 1.0 and f2 = 3.0 
according to DIN 18800 T1, El. (748) are set by default. 

 stress is to be determined for the stress de-
sign as shown e.g. in DIN 18800 T1, El. (747). 

nt Stress σ v 

The factors f1 and f2 can be defined in dialog Details. Th
 

Stress Ratio 
The quotient of the existing stress and the limit
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The stress ratio of the cross-section at the selected stress point can be read for every type of 
internal force (cf. chapter 5.1, page 34 ). The stress ratios due to axial, shear and equivalent 
stresses are set by default for the tabular output data. If the limit stress is not exceeded, the 
stress ratio is smaller than or equal to 1.0 and the stress design is considered to be fulfilled. 

 

1
d,R

≤
σ
σ

 

Equation 3.1: Design requirement for axial stresses 

 

1
d,R

≤
τ
τ

 

Equation 3.2: Design requirement for shear stresses 

1eqv ≤
σ

 
d,Rσ

Equation 3.3: Design requirement for equivalent stresses 

3.2 Details 
The dialog to check the calculation parameters can be called up via the [Details] button in 
every STEEL mask. 

 
Figure 3.2: Dialog Details 

Display Result Tables 
This section controls the display of the result masks. 

The mask 2.5 Stresses at Every Stress Point is by default deactivated because the stress 
graphics offer also access to the stress points. When checking the stresses in the tables, it 
might be advisable to display this mask. 

The displayed values in mask 3.1 Governing Internal Forces usually refer to the equivalent 
stress σeqv. It is possible to select a different stress type from the list. 
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Plastic Approximate Calculation 
Allow Local Plastification 
Also the Local Plastification according to DIN 18800 T1, El. (749) can be considered for the 
design. Here, the equivalent stress σv is permitted to exceed the permitted limit stress in 
small areas by 10 %. STEEL determines whether the two conditions described in El. (749) for 
accepting ‘small areas’ are fulfilled. 

d,RMN 8.0
y

σ⋅≤σ+σ  

Equation 3.4 

d,RMN 8.0
z

σ⋅≤σ+σ  

Equation 3.5 

If this is the case, the limit stress for the design of σv will be increased. 

Plastic Shape Factor αpl 

The axial stresses can optionally be reduced by the Plastic Shape Factor αpl as described in 
DIN 18800 T1, El. (750). This option refers to the stresses σM due to the bending moments 
My and Mz. 

y
zz,pl

z
z

yy,pl

y
M e

I
M

e
I

M
⋅

⋅α
±⋅

⋅α
±=σ

-

 

ot be taken into account for the 
ding stresses. 

 processed row by row for every extreme value including the 

g Internal Forces the relevant rows 
of the RSTAB results table 3.1 Internal Forces reappear. 

 

Equation 3.6 

If this option is to be applied, STEEL assumes the shape factors αpl,y = 1.14 and αpl,z = 
1.25. The allowance for local plastification extends exclusively to rolled I-shaped cross-
sections. 

Method of Stress Calculation 
When acting on two axes, the member internal forces of load combinations may under cer
tain circumstances not lead to the maximum stresses. For example, in one load case with 
vertical loads only moments My (and no moments Mz) occur and in a different load case 
with horizontal loads only moments Mz (and no moments My) occur. The two load cases 
are superimposed with as ‘variable’ load cases within a load combination. In the RSTAB ta-
ble 3.1 Internal Forces, the moment Mz is classified as not corresponding to the maximum 
moment My because the horizontal loads do not increase the moment due to vertical loads.
If the design of the Stresses from Internal Forces was carried out, the simultaneous influ-
ence of the two different types of internal forces would n
combined consideration of the ben

Stresses from Internal Forces 
According to this method, the results of the RSTAB table 3.1 Internal Forces are used for the 
design. The max/min results are
corresponding internal forces. 

The advantage of this design option is that the results of the load combinations can be 
used directly. This speeds up the processing time. Additionally, the designed internal forces 
are transparent because in the STEEL mask 3.1 Governin
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Calculate Stresses from Load Cases and then Combine Stresses 
This method of calculation is set by default for load combinations. Initially, the axial and 
shear stresses of the contained load cases are determined. They are then superimposed ac-
cording to the CO combination criterion. This guarantees that the above-described effects 
in the case of exclusively uniaxial bending loads do not result in too small stress ratios. 

The design is carried out by stress points. The compressive, tensile and shear stresses are 
added accordingly and then presented in the results masks. The equivalent stress σeqv 
makes an exception, however: It is determined with the components from σtotal und τtotal. 

os. 
Superimposing the equivalent stresses from the single load cases would not be correct as 
this would lead to oversized stress rati

This method of calculation is slightly more time-consuming. Additionally, the values that are 
represented in mask 3.1 Governing Internal Forces are more difficult to reconstruct if they 
are related to the equivalent stresses. 

In more complex 3D models of RSTAB, hardly any exclusively uniaxial bending moments oc-
cur. Thus, both methods of stress calculation should lead to the same stress ratios. 

Calculation of Equivalent Stress Sigma-eqv 
In this dialog section, the factors for the determination of the equivalent stress can be ad-
justed. 

2
total2

2
total1eqv ff τ⋅+σ⋅=σ

pplied. 

 

with  f1: Factor for axial stresses 

  f2: Factor for shear stresses 

Equation 3.7 

The factors f1 = 1.0 and f2 = 3.0 as specified in DIN 18800 T1, El. (748) are set by default. 

Eccentric Loading for I-Beams with Large Depths 
If transverse loads are introduced to the top flange of a girder, their influence on the bend-
ing stress of the bottom flange will decrease with growing cross-section depth. For this rea-
son, eccentric transverse loads can be considered for high I-shape cross-sections with a 
simplified approach: The stress due to the bending moment Mz is calculated only on the 
top flange for every (!) rolled or welded symmetric I-shape cross-section that is to be de-
signed in the current STEEL case. For this, an equivalent cross-section with half of the mo-
ment of inertia Iz is a

With this option, the loads can be entered in the RSTAB model with respect to the centroid 
axis to avoid torsion. Because this checkbox affects all rolled and symmetric I-shape cross-
sections of the design case, it is recommended to design all I-beams with large depths in a 
separate STEEL case. 
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3.3 Starting the Calculation 
You can [Calculate] the current STEEL case via the corresponding button in all three input 
masks of the STEEL module.  

STEEL searches for the results of the load cases, load groups, combinations and super com-
binations that are to be analyzed. If these are not found, then STEEL first starts the RSTAB 
calculation of the internal forces that are necessary for the design. For this, the current 
RSTAB calculation parameters are used. 

If an optimization of the cross-sections (c.f. chapter 7.2, page 49) is to be carried out, then 
first the required cross-sections will be defined and after that the stresses will be calculated. 

You can also initiate the calculation of the STEEL results from the RSTAB interface. The addi-
tional modules are listed in the dialog To Calculate like load cases or load groups. This di-
alog can be called up in RSTAB via 

Calculation → To Calculate. 

 
Figure 3.3: Dialog To Calculate 

If the STEEL design cases are missing in the list Not Calculated, then the checkbox Show 
Additional Modules has to be activated. 

The selected STEEL cases can be moved to the right via the [ ] button. The calculation can 
the be started by pressing the corresponding button.        

 

 
 

  

A selected STEEL case can also be started via the tool bar. Set the selected design case and 
click on the button [Results on/off]. 

 
Figure 3.4: Direct calculation of a STEEL design case in RSTAB 
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4. Results 
 

The mask 2.1 Stresses by Cross-Section appears right after the calculation. The stresses and 
stress ratios are listed in detail in the result masks 2.1 to 2.5. The following masks 3.1 to 3.3 
contain the governing internal forces. The result masks are accessible via the STEEL naviga-
tor. Alternatively, the two buttons shown on the left or the keys [F2] and [F3] can be used 
to scroll from one mask to the next. 

     

With [OK], you can store all the results and close the STEEL module. 

This chapter presents a description of the individual masks. Details to evaluating and check-
ing the results can be found in the next chapter 5. 

4.1 Stresses by Cross-Section 

 
Figure 4.1: Mask 2.1 Stresses by Cross-Section 

This mask issues the maximum stresses for all members selected for the design resulting 
from the relevant load cases, load groups or combinations. The listing is sorted by cross-
sections. For a tapered member, both cross-section descriptions are shown in the row next 
to the cross-section number. 

The stress components displayed in column E Stress Type depend on the settings in dialog 
Stresses - Filter (see Figure 5.3, page 34). This dialog is accessible via the button shown on 
the left. 

 

Member No. 
For every cross-section and stress type, the member number is issued that presents the 
highest stress ratio. 

 



4  Results 

Location x 
The location x in the member is presented for which the maximum value of the stress was 
determined. For the tabular output, these RSTAB member locations x are used: 

• Start and end nodes 
• Division points according to possible user-defined member division 
• Extreme values of internal forces 

S-Point No. 
The design is carried out at so-called Stress Points of the cross-sections. These are locations 
of the cross-sections that are defined by centroid distances, statical moments and cross-
section thicknesses. The design according to the equations of Table 3.1 and Table 3.2 can 
be carried out with the help of the cross-section properties. 

All standard cross-sections of the library as well as the Shape-Thin and Shape-Massive cross-
sections already contain stress points at the design-relevant locations of the cross-sections. 
The parameters for user-defined cross-sections have to be defined manually or imported. 

You can view the stress points and their numbering in the graphics on the right. The current 
stress point (i.e. the stress point in the row of the cursor position) is highlighted in red.      

The [Info] button can be used to check the relevant parameters of the stress points. First, 
the dialog Info about Cross-Section with the listing of all cross-section parameters is called 
up. In this dialog below the picture of the section, the button [Details] allows to access the 
details for the stress points. 

 
 

 

 
Figure 4.2: Info about cross-section: Stress Points 
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The columns Coordinates y and z list the centroid distances ey resp. ez, the columns Statical 
Moments of Area the values of Qy and Qz with respect to the governing axis y resp. z. The 
Thickness t represents the component thickness at the selected stress point. The values in 
the columns Warping are not relevant for the STEEL design. 

The stress analysis is carried out for every individual stress point. Therefore, usually not all 
components of the maximum stresses may be added for the combined display (e. g. σeqv) as 
those are available at different stress points in most cases. Instead, the stress components 
that exist at the same stress points must be combined. The evaluation of the results by 
stress points can be carried out e.g. in mask 2.5 (see chapter 4.5, page 29) or in window 
Cross-Section Values and Stress Diagram (see Figure 5.5, page 36). 

 

Load Case 
Column C presents the load case, load group, load combination or super combination 
whose internal forces produce the maximum stresses. 

Stress Type 
The axial stresses σtotal, the shear stresses τtotal and the equivalent stresses σeqv are listed by 
default. The determination of these stresses is presented in Table 3.1, Table 3.2 and Table 
3.3 on pages 18 to 19. 

The stress components that are contained in the total stresses can be viewed as shown in 
Figure 4.3. The individual stress components can be selected in dialog Stresses - Filter (c.f. 
Figure 5.3, page 34). This dialog is accessible via the button shown on the left. 

 

Stress Existing 
This column presents the extreme values of the existing stresses that are determined accord-
ing to the equations of Table 3.1, Table 3.2 and Table 3.3 (see pages 18 to 19). 

Stress Limiting 
Here you can find the limit stresses of mask 1.2 (see chapter 2.2, page 10). In detail, these 
are the following stresses: 

• The limit axial stress σx represents the allowable stress for the loading due to bending 
and axial force. 

• The limit shear stress τ is the allowable shear stress due to shear force and torsion. 
• The limit equivalent stress σeqv represents the allowable equivalent stress for the si-

multaneous action of axial and shear stresses. 

Stress Ratio 
For every stress component, the quotient of the Stress Existing and the Stress Limiting is de-
termined. If the limit stress is not exceeded, then the stress ratio is smaller than or equal to 
1.00 and the stress design is considered to be fulfilled. 
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4.2 Stresses by Set of Members 

 
Figure 4.3: Mask 2.2 Stresses by Set of Members 

This result mask is displayed when one or more sets of members have been selected for de-
sign. The listing of the maximum stresses is sorted by sets of members. 

The numerical output by sets of members has the advantage that the stress design of a 
complete structural group (e.g. a frame) is presented in a single results mask. 

The individual columns are presented in chapter 4.1, page 24. Additionally, in column A 
Member No. the number of the member is presented that has the highest stress ratio with-
in the set of members. 
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4.3 Stresses by Member 

 
Figure 4.4: Mask 2.3 Stresses by Member 

In this results mask, the maximum stresses are listed by member numbers. For every mem-
ber, the Location x is specified where the maximum occurs. 

The individual columns are presented in the chapter chapter 4.1, page 24. 

4.4 Stresses by x-Location 

 
Figure 4.5: Mask 2.4 Stresses by x-Location 

This result mask lists the maximum stresses for every member at the locations x resulting 
from the RSTAB member divisions: 

• Start and end nodes 
• Division points according possible user-defined member division 
• Number of divisions for the member results as defined in register Options of the 

RSTAB dialog Calculation Parameters 
• Extreme values of the internal forces 
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4.5 Stresses at Every Stress Point  

 
Figure 4.6: Mask 2.5 Stresses at Every Stress Point 

Because the evaluation by stress points is usually not required, this results mask is disabled 
by default. However, you can activate it the Details dialog (see Figure 3.2, page 20) that can 
be called up via the [Details] button from every mask. 

 

The presentation of this mask results in a large amount of data. Because the maximum 
stresses and, along with them, the governing stress points are determined automatically, it 
is usually not necessary to display the mask 2.5. Additionally, specific means of evaluation 
are available in the previous masks via the [Cross-Section and Stress Diagram] button. In the 
Cross-Section Values and Stress Diagram dialog (cf. Figure 5.5, page 36), the design results 
can be evaluated graphically and numerically at every stress point. 

The listing of the stresses is sorted for every member by Location x and by Stress Point. De-
tails to the individual columns of this mask can be found in chapter 4.1, page 24. 
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4.6 Governing Internal Forces 

 
Figure 4.7: Mask 3.1Governing Internal Forces 

In this mask, the governing internal forces are displayed that entail the maximum stress ra-
tios of every member. The reference to the equivalent stress σeqv is set by default. It is poss-
ible to define the reference to a different stress type in the Details dialog (see Figure 3.2, 
page 20). This dialog can be called up via button [Details]. 

 

The design option Calculate Stresses from Single Load Cases in CO and then Combine 
Stresses according to CO Criteria makes it impossible to directly use the table rows of the 
RSTAB results table 3.1 Internal Forces. The compressive, tensile and shear stresses in the 
single load cases are added accordingly and then presented in the STEEL results masks. The 
equivalent stresses σeqv, however, are calculated with the components of σtotal and τtotal so 
that the values of this mask 3.1 may not be transparent immediately. 

Location x 
For every member, the location x is specified where the maximum stress ratio occurs. 

Load Case 
This column displays the numbers of the load case, group, combination or super combina-
tion whose internal forces cause the maximum stresses on the member. 

Forces / Moments 
The governing axial and shear forces as well as the torsional and bending moments are is-
sued for every member. 
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4.7 Parts List by Members 

 
Figure 4.8: Mask 3.2 Parts List by Member 

Finally, a summary of the cross-sections from the design case is displayed. By default, only 
the designed members are contained in this list . The Details dialog can be used to select a 
parts list of all members of the structure (c.f. Figure 3.2, page 20). This dialog can be called 
via the button shown on the left. 

 

Part No. 
Part numbers are issued automatically for members of the same type. 

Cross-Section 
This column lists the cross-section descriptions. 

Number Members 
This column shows how many members of the same type exist. 

Length 
In this column, the lengths of a single member are listed. 

Total Length 
This column contains the product of the two previous columns. 

Surface Area 
This column shows the surface areas of every part. They refer to the total lengths and are 
determined from the value ASurf of every cross-section. This value can be checked in masks 
1.3 to 2.4 via the [Info about Cross-Section] button. 

 

Volume 
The volume of every part is determined from the cross-section area and the total length. 
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Single Weight 
The Single Weight of the cross-section represents the mass with reference to a standard 
length. For tapered cross-sections, the average is determined of both cross-sections. 

Weight 
The values of this column represent the product of columns C and G. 

Total Weight 
The last column displays the total weight of every part. 

Sum 
The final row gives the sums of every column. The required amount of steel is displayed in 
the final cell Total Weight. 

4.8 Parts List by Set of Members 

 
Figure 4.9: Mask 3.3 Parts List by Set of Members 

The last STEEL mask is only available if one or more sets of members have been selected for 
the design. The output by sets of members allows for a specific parts list of a complete 
structural group (e.g. a frame). 

The individual columns are presented in the pervious chapter 4.7. If there are different 
cross-sections within the set of members, the average values of surface area, volume and 
single weight will be determined. 
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5. Result Evaluation 
After the design, the results can be evaluated in different ways. The buttons below the 
graphics on the right are used for the different evaluation types. 

 
Figure 5.1: Buttons for result evaluation 

The buttons in this dialog have the following functions: 

Button Description Function 

 Stress Diagram 
Switches the graphic display of the stresses on the 
cross-section on and off 

 Stress Ratio 
Switches the graphic display of the stress ratio on and 
off 

 Values 
Switches the values in the graphics of the stresses or 
stress ratio on and off 

 
Cross-Section 
Outlines 

Controls the display of the outlines in the cross-section 
graphics 

 Stress Points 
Switches the stress points in the cross-section graphics 
on and off 

 Numbering Switches the numbering of the stress points on and off

 Cross-Section Info  
Calls up the Info about Cross-Section dialog with the 
parameters of the current cross-section 

 Result Diagram 
Opens the Result Diagram on Member  

 chapter 5.4, page 40 

 Relation Scales Switches the color bars in the results masks on and off 
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 Exceeded Ratio > 1
Shows only rows with stress ratios larger than 1 and, 
accordingly, failed design 

 Select Stresses 
Opens the Stresses - Filter dialog 

 chapter 5.1, page 34 

 
Extended Stress 
Diagram 

Opens the Cross-Section Values - Stress Diagram dialog 
 chapter 5.2 page 35 

 General View 
Displays the stress graphics again completely 
(Zoom with scroll wheel, move via Drag & drop) 

 View Mode 
Allows jumping to the RSTAB work window in order to 
arrange a different view 

 Pick Member 
A member can be selected in the RSTAB window 
whose stresses will then be set in the table. 

Table 5.1: Buttons in the Results Masks 2.1 to 2.5 

5.1 Selection of the Stresses 
After the design, the following stress types are presented by default: 

• Axial stresses σtotal 

• Shear stresses τtotal 

• Equivalent stress σeqv 

Via the button [Select Stresses to Show], additional stress types can be activated. They can 
be used to check the individual stress components that are contained in the total stresses.  

 
Figure 5.2: Button [Select Stresses to Show] 

The following dialog appears: 

 
Figure 5.3: Dialog Stresses - Filter 

In this dialog, the relevant stress types can be selected. Deta
be found in Table 3.1 and Table 3.2 on page 18 ff. 

ils to the individual stresses can 
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Two buttons assist with the selection. These have the following functions: 

Button Description Function 

 Select all All stress components are selected. 

 Deselect all All stresses types are deselected. 

Table 5.2: Buttons in t  dialog 

The design is carried out at every single stress point. Thus, usually not all components of the 
 the combined evaluation (e.g. σtotal) as those appear 

Section 

he Stresses - Filter

maximum stresses must be added for
at different stress points. For the correct evaluation, only the stress components of the se-
lected stress point are to be superimposed. 

5.2 Results on Cross-
The graphics of the stresses are displayed to the right of the ta
These are dynmacial graphics because they show the stresses 

bular listing of the stresses. 
at the current location x resp. 

 stress point of the cursor position in the table. The current stress point is highlighted in red.

 

Figure 5.4: Distribution of the axial and be

With the scroll wheel, you can

nding stresses on the cross-section 

 zoom the display in and out, via drag & drop you can move 
w. 

-

s-section outlines, 

 the stress graphics. The button shown on the left restores the general vie

Details to the buttons below can be found in Table 5.1 on page 34. With these you can con
trol whether 

 
• the stresses or stress ratio including their values, 
• the cros 

 
• the stress points and their numbering 

are to be displayed. 
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Via the button [Cross-Section Values and Extended Stress Diagram], a specific evaluation of 
the stresses is possible for every stress point. It calls up the following dialog. 

 
Figure 5.5: Dialog Cross-Section Values and Stress Diagram 

In section Position, the current Member No. and the location x are preset. You can also se-
lect different members or x-locations from the list. 

The section Stress Points lists all stress points of the cross-section. The columns Coordinates 
show the centroid distances ey and ez, the column Statical Moments present the statical 
moments of area  Qy and Qz. The last column shows the Thickness t for the component that 
is relevant for the determination of the shear stresses. 

Section Stresses below lists the individual stress components at the current stress point, i.e. 
the Point that is selected in the section above. Here too, you can select stress components 
that are then displayed dynamically in the graphics to the right. 

The buttons below the graphics are largely similar to those presented in Table 5.1, page 34. 
They are also explained by Quick Infos. A special function is assigned to the [Print] button  
that allows you to print the current stress graphics. For more details, see chapter 6.2.1 on 
page 44. 

 

 



5  Result Evaluation 

5.3 Results on the RSTAB Model 
You can also use the RSTAB work window for the evaluation of the design results. On the 
one hand, the RSTAB graphics in the background are of assistance when you want to check 
the location of a specific member in the model: The member that is selected in the STEEL 
results mask is highlighted in the RSTAB background graphics. Additionally, an arrow marks 
the location x on the member that is marked as governing in the current STEEL row. 

 

 
Figure 5.6: Identifying the Member and the current Location x in the RSTAB model 

If you cannot correct a disadvantageous view by moving the STEEL window, then it is poss-
ible to use the so-called View Mode via the button [Change View] to adjust the view: The 
STEEL window will be hidden, and the view can be modified in the RSTAB interface. In this 
mode, you can access the View menu, e.g. to zoom, move or rotate the view. 

 

On the other hand, the stresses as well as ratios can be visualized directly on the model of 
structure. The [Graphic] button is used to quit the STEEL module. The design results will be 
presented in the RSTAB work window graphically, comparable to the internal forces of a 
load case. 
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The items of the Results navigator are adjusted to the STEEL design results. Here, all stress 
components as well as the ratios referring to the single stress components are available. 

 
Figure 5.7: Results Navigator 

As for the RSTAB internal forces, the button [Results on/off] switches the display of the de-
sign results on or off. The button [Show Result Values ] controls the display of the result 
values in the graphics. 

   

Because the RSTAB tables are irrelevant for evaluating the STEEL results, you can deactivate 
the table display.  

The selection of the design cases is carried out as usual via the list in the RSTAB menu bar. 

 

The presentation of the results can be controlled in the Display navigator among the item 
Results → Members. The stresses and stress ratios are displayed in two colors by default. 
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Figure 5.8: Display Navigator: Results → Members 

The stresses are also in two colored view shown with their signs: Positive stresses are dis-
played in blue in the direction of the positive member axis z, negative stresses are drawn in 
red at the opposite side of the member. Therefore, it is possible that the sign and therefore 
the stress diagram swaps color and side if there are discontinuities on certain members, e.g. 
due to single loads. 

For a multicolor view, the control panel is available. The description of this Panel can be 
found in the RSTAB manual (chapter 4.4.6, page 71 ff). As for the internal forces, you can 
scale the design results in register Filter. If you enter the factor 0 in the input field Member 
Diagrams, the stresses and ratios are automatically shown with an increased line thickness. 

 

 

 
 
 

Figure 5.9: Stress ratios due to bending moment My with display type Cross-Sections 

These graphics can be also printed to the RSTAB printout report (cf. chapter 6.2.2, page 45). 

You can always return to the STEEL module via the [STEEL] button in the panel as shown on 
the left. 
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5.4 Result Diagrams 
If you want to view the results of one or more selected members, then also the result dia-
grams can be used. Select the member(s) or set of members in the STEEL results mask and 
activate the result diagram via the button shown on the left. 

 
 
 

Alternatively, the result diagrams are available in the RSTAB graphics via menu 

Results → Result Diagrams on Selected Members 

or the corresponding button in the RSTAB toolbar. 

 
 A new window appears that displays the result diagrams of the member(s) or set of mem-

bers. 

 
Figure 5.10: Dialog Result Diagrams on Member 

In the navigator on the left, the stresses and stress ratios can be selected that are to be dis-
played in the diagram. Via the list of the tool bar, you can choose among the different 
STEEL design cases. 

 

The detailed description of the Result Diagram on Member dialog can be found in chapter 
9.8.4 of the RSTAB manual, page 221 ff. 
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5.5 Filtering Results 
Apart from the STEEL results masks that allow for a selection according to specific criteria 
due to their structuring, the filter options as described in the RSTAB manual are available to 
graphically evaluate the STEEL design results. 

You can use already-defined partial views (cf. RSTAB manual, chapter 9.8.6, page 224 ff) 
which group objects in a suitable manner.  

It is also possible to use the stresses and stress ratios as filter criteria within the RSTAB win-
dow. For this, the panel is to be displayed. If it is not visible, you can activate it via menu  

View → Panel 

or the corresponding button in the Results toolbar. 

Details to the control panel can be found in chapter 4.4.6 of the RSTAB manual, page 71 ff. 
The filter settings for all results are carried out in the register Color Spectrum. As this regis-
ter is not presented in two-colored display, it can be switched on by selecting the display 
types Colored or Cross-Sections in the Display Navigator. 

 
Figure 5.11: Display Navigator: Results → Members → Colored 

For a colored view of the stresses, you can define in the panel that e.g. only the equivalent 
stresses greater than 100 N/mm  ́are to be displayed. Additionally, the color spectrum can 
be adjusted so that each color range covers 10 N/mm  ́(see Figure 5.12). 

Via the option Display hidden result diagram (in the Display navigator among the item 
Results → Members), also all stresses can be displayed that do not fulfill this requirement. 
These would be shown as dotted lines. 
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Figure 5.12: Filtering stresses with adjusted color spectrum 

Filtering Members 
In the register Filter of the panel, you can specify the numbers of the members whose 
stresses are to be shown exclusively in the graphics. Details to this function can be found in 
chapter 9.8.6 of the RSTAB manual on page 224. 

 

Unlike the partial view, here the structure is shown completely. The following figure shows 
the axial stresses in the inner frame of a structure. The remaining members are displayed in 
the model but are without internal forces. 

 



6  Printout 

 

Figure 5.13: Filtering members: Axial stresses of a selected frame 

6. Printout 
 

6.1 Printout Report 
Also for the STEEL design results, a printout report is generated that can be amended by 
graphics and descriptions. There, you can also define which STEEL result masks are to be in-
cluded in the printout report. 

Details to the printout report can be found in the RSTAB manual. Especially chapter 10.1.3.4 
Selection of Add-On Modules Data (page 240) deals with the selection of the input and 
output data for all add-on modules. 

For very large structures, it is advisable to split the data into several reports. If you create an 
extra report with only the STEEL data of a design case, then this printout report can be easi-
ly created. 

In the printout report, those stress components are listed that have been set in the selected 
STEEL design case for the result masks. If e.g. the stresses due to axial forces are to be in-
cluded, the stresses σN are to be activated in the STEEL module. Details to this function can 
be found in chapter 5.1, page 34. 

6.2 Printing STEEL Graphics 
Similar to the results evaluation, the stresses and stress ratios can be used for the printout 
both on the cross-section as well as on the RSTAB model. It is possible to include the images 
in the printout report or to directly print them. Details on printing graphics can found in 
chapter 10.2 of the RSTAB manual. 
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6.2.1 Results on Cross-Section 
The print function is indirectly accessible via the Cross-Section Values and Stress Diagram 
dialog (see Figure 5.5, page 36). This dialog can be called up in the results masks 2.1 to 2.5 
via the button [Cross-Section Values and Stresses]. 

 

 
Figure 6.1: Button Cross-Section Values and Stresses in the graphics of the result masks 

In the Cross-Section Values and Stress Diagram dialog, you can select the relevant member, 
location x and stress type whose diagram is to be printed. Via the [Print] button in this di-
alog (at the bottom to the right), the following dialog is called up. 

 

 
Figure 6.2: Dialog Print Info about Cross-section 

The familiar options are available in section Print Type: 

• Direct to Printer sends the current graphics to the printer. 

• To Printout Report inserts the graphics in a printout report. 

• To Clipboard makes the graphics available for other applications. 

If several printout reports exist, the number of a specific report can be selected from the 
list. 

 



6  Printout 

The section Printout Selection controls which elements will appear in the printed image and 
in a numerical table. The objects listed under Create Graphics of Cross-Section do not re-
quire any additional explanation. If the option Cross-Section Properties is active, then the 
cross-section parameters will be printed tabularly. Symbolizing graphics can optionally be 
added at the margin. In the same way, the properties of the Stress Points and (c/t) Parts as 
well as the Stresses in All Stress Points can be included in the printout report. 

When you close the dialog with [OK], the printout report will be opened by default. If you 
want print several graphics successively, it is recommended to deactivate the checkbox 
Show Printout Report on [OK]. 

 
Figure 6.3: Stress graphics in the Printout Report 

6.2.2 Results on the RSTAB Model 
Like in RSTAB, every image that is shown in the graphics of the main program can be in-
cluded in the printout report. In the same way, the result diagrams can be added to the re-
port via [Print]. 

 

The current STEEL graphics can be printed via menu 

File → Print 

or via the appropriate button in the toolbar. 

 
Figure 6.4: Button Print in the RSTAB toolbar 
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Figure 6.5: Button Print in the toolbar of the Result Diagram window 

The following dialog appears. 

 
Figure 6.6: Dialog Graphic Printout, register General 

Details to this dialog can be found in chapter 10.2 of the RSTAB manual, page 259 ff. There, 
also the detailed description of the registers Options and Color Spectrum can found. 

In the printout report, every STEEL image can be moved by drag & drop to a different loca-
tion. It is also possible to modify an image: Click on the selected item in the report naviga-
tor with the right mouse button and select its Properties from the context menu. Again the 
dialog Graphics Printout with several options appears to edit the image. 

 
Figure 6.7: Dialog Graphic Printout, register Options 
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7. General Functions 
The last chapter explains some menu functions as well as export options of the design re-
sults. 

7.1 STEEL Design Cases 
You can organize the members in separate design cases. With this, you can combine certain 
components of the structure or to assigne specific design parameters (e.g. limit stresses, 
partial safety factors, optimization etc.). 

A member or a set of members can be examined without any problem in different design 
cases. 

The STEEL cases are available in the RSTAB work area like any load case or load group in the 
list of the menu bar. 

 

Create a New STEEL Case 
A new design case can be created via the STEEL menu 

File → New Case. 

The following dialog appears. 

 
Figure 7.1: Dialog New STEEL Case 

In this dialog, you can enter a Number that has been not used yet and a Description for the 
new design case. After [OK], the STEEL mask 1.1 General Data for the input of the new data 
appears. 

Rename STEEL Case 
The description of a design case can be modified via the STEEL menu 

File → Rename Case. 

The dialog Rename STEEL Case appears. 

 
Figure 7.2: Dialog Rename STEEL Case 
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Copy STEEL Case 
The input data of the current design case are copied via the STEEL menu 

File → Copy Case. 

The dialog Copy STEEL Case appears. Here you have to enter the number and a description 
for the new design case. 

 
Figure 7.3: Dialog Copy STEEL Case 

Delete STEEL Case 
Design cases can be deleted via the STEEL menu 

File → Delete Case. 

In dialog Delete STEEL Case, you can select a specific STEEL case that is to be deleted. 

 
Figure 7.4: Dialog Delete Cases 

 



7  General Functions 

7.2 Cross-Section Optimization 
STEEL is able to optimize cross-sections during the design. For this, you have to select the 
cross-section by activating the checkbox in column D of mask 1.3 (see Figure 2.5, page 14). 

During the optimization, STEEL examines which cross-section within the same cross-section 
series fulfills the design “best”, i.e. closest to the maximum stress ratio of 1.0. With the in-
ternal forces from RSTAB, the required moment of inertia is determined. After this, the 
cross-section is chosen from the relevant cross-section group that fulfills the design with the 
highest possible ratio. As a result, two cross-sections are shown graphically in mask 1.3 (cf. 
Figure 2.5, page14): the original cross-section from RSTAB and the optimized cross-section. 

You can enter detailed settings for the parametrized cross-sections. After activating the op-
timization box, a dialog appears. 

 
Figure 7.5: Dialog Welded Section - I Symmetric: Optimize 

In column Optimize, you can select the parameter that is to be modified by activating the 
checkbox. This makes the columns Minimal and Maximal accessible. These define the lower 
and upper limits of the parameter for the optimization. The column Increment controls in 
which intervals the dimensions of this parameter vary during the optimization process. 

To Keep the Current Side Proportions, you have to activate the checkbox below the parame-
ter settings. In addition, all parameters have to be activated for the optimization. 

No optimization can be carried out for combined rolled cross-sections. 

When optimizing, keep in mind that the internal forces are automatically recalculated to-
gether with the modified cross-sections. The user can decide when and which cross-sections 
are to be recalculated in RSTAB. Due to the changed stiffnesses within the model, signifi-
cant differences can occur in the internal forces that result from optimized cross-sections. It 
is therefore advisable to recalculate the internal forces after a first optimization run and 
then optimize the cross-sections once more. 

 

The export of the modified cross-sections to RSTAB does not need to be carried out by 
hand. Open mask 1.3 Cross-Sections and select menu 

Edit → Export All Cross-Sections to RSTAB. 

Also the context menu of the cross-sections in mask 1.3 can be used to export modified 
cross-sections to RSTAB. 
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Figure 7.6: Context menu of Mask 1.3 Cross-Sections 

Because this action involves the deleting of results, a query appears before exporting. If the 
[Calculation] is then started in STEEL, then the calculation of both the internal forces in 
RSTAB and the stresses in STEEL is carried out in one calculation run. 

 
Figure 7.7: Query before exporting modified cross-section to RSTAB 

You can also reimport the original RSTAB cross-sections via the above described menu func-
tions. This option is only available in mask 1.3 Cross-Sections. 

If a tapered member is to be optimized, then the start and end locations are optimized. Af-
ter this, the moments of inertia can be linearly interpolated on the intermediate locations. 
The stress analysis becomes inaccurate when encountering extremely different start and end 
cross-sections as these are taken into account by the power of four. In this case, the ta-
pered members should be divided in single members whose start and end cross-sections 
have smaller differences. 
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7.3 Units and Decimal Places 
The units and decimal places are managed globally for RSTAB and for all add-on modules. 
In STEEL, the dialog for setting the units is available via menu 

Settings → Units and Decimal Places. 

The dialog that is already known from RSTAB is called up, and the module STEEL is preset. 

 
Figure 7.8: Dialog Units and Decimal Places 

The settings can be saved as user profile and applied later in different structures. Details to 
this function can be found in chapter 11.6.2 of the RSTAB manual, page 344.      

7.4 Exporting Results 
The results of the stress analysis can be made available for other programs in different 
ways. 

Clipboard 

Marked cells of the STEEL results masks can be copied via [Ctrl]+[C] in the clipboard and 
then be inserted via [Ctrl]+[V] e.g. in a text processing program. The headers of the table 
columns are not considered for this. 

Printout Report 

The STEEL data can be printed to the printout report (cf. chapter 6.1, page 43) and then be 
exported via menu 

File → Export to RTF file or BauText. 

Details to this function can be found in chapter 10.1.11, page 254 of the RSTAB manual. 
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MS Excel Format *.xls 

STEEL allows to directly export data to MS Excel. This function can be activated via 

File → Export in MS Excel. 

The following export dialog is opened. 

 
Figure 7.9: Dialog Export - MS Excel 

The export can be started via [OK] as soon as the parameters have been selected. Excel is 
automatically called up, it does not need to be opened in the background. 

 
Figure 7.10: Results in Excel 
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